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Getting Started

How Email Works @ De Anza
When you use Eudora Pro to send and receive email, the Eudora program is serving as a
liaison between you and the FHDA email server(s) (Mercury and Admin). The email
servers store your email messages and manage the email traffic for FHDA employees.

To communicate with the email servers on campus, Eudora must be configured properly.
The configuration process is completed by De Anza AV staff when the Eudora software is
installed on your computer.

When you receive email messages from Eudora, you are “pulling” them from the email
server and saving them on your local machine. This means that once you receive an email
message in Eudora, the message can only be accessed from your computer.

Opening Eudora
You open Eudora by double clicking on the Eudora Pro icon in your Eudora Pro Folder. If you
can not locate your Eudora Pro folder, use your computer’s Find function to locate it.

Understanding the Eudora Toolbar
When Eudora Pro is open,  the Eudora toolbar will appear on your desktop. This toolbar
provides buttons that allow you access to the most common tasks performed in Eudora.

When you hold your mouse pointer over a button in the toolbar, the function of that button
appears below the button.
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Checking and Reading Mail

Checking Mail
Once you’ve opened Eudora, you need to log on to the mail server using your password. You
do this by checking your mail.

To Check Your Mail

1. Select Check Mail from the File menu or click on the Check mail button in
the Eudora Toolbar. A window will appear, prompting you to enter your
password.

2. Enter your password and click OK.

A window will appear stating whether or not you have new mail— click OK in this
window. If you have new mail, an “In” window will appear on your desktop listing the
mail you have.

After you log into Eudora for the first time, you do not have to enter your password every
time you check for mail—Eudora will remember your password as long as the program
remains open.
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Automatic Email Checks
You can set up Eudora to automatically check your mail at set times throughout the day.
Using this feature will enable you to  work in other programs and have your email
checked periodically. When you receive new mail, a message will appear on your
desktop.

Note:

You must open the Eudora application, log on, and leave the
application open in order for the automatic email check to work.

Set Up Automatic Email Check

1. Go to the Special pull-down menu and select Settings. A window will
appear.

2. Select Checking Mail in the left column.

3. Click on the box to the right of “Check for mail every ____ minutes” to
activate this feature (A check box should appear).

4. Insert the intervals at which you want your email checked in the box.

5. Click OK.
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Reading Mail

Tip!

Before you read this section, you should make sure that your “In”
window is visible on your desktop. If this is not the case, select “In”
from the Mailbox pull-down menu.

Read Your Email Messages

1. Double-click on the sender’s name, the date, or the message topic. Your
message will open in it’s own window.

2. When you are finished reading the message, close the message window by
clicking the close box in the upper left corner. (Responding to messages is
discussed in the upcoming chapters.)
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Eudora Mailboxes and Windows

About Mailboxes
Every piece of mail you send, receive, or delete is stored in a Mailbox. The default
mailboxes in Eudora are the “In,” “Out,” and “Trash” boxes. The In box is where new mail
and mail you’ve read, but want to save, is stored. The Out box stores the messages you’ve
sent to other people. The Trash box stores the files you’ve deleted.

Opening Mailboxes
After you log on to Eudora, the In box will open and be displayed as a window on your
desktop. When you close the In box, but leave Eudora open, the In box will re-open every
time you receive mail. You can have multiple mailboxes open at the same time.

To Open a Mailbox

1. Select the mailbox you want to open from the Mailbox pull-down menu.

Understanding Column Labels in Windows
When a mailbox is open, it is displayed as a window on your desktop. That window
contains multiple column headings:

Note:

You may have more column labels in your Eudora window. The column
labels visible are specified in your Eudora settings.

Chapter
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Status
Status indicates what you’ve done with the message in your mailbox (read, forwarded,
replied, etc.). You can see a key for the different icons in the Status column.

Locate the Status Column Key

1.  Click once on a message in your In, Out, or Trash mailbox.

2. Place your mouse pointer in the Status column. Your pointer icon will look
like the image on the right.

3. Click and hold down on your mouse button. A key to the icons in the Status
column will appear.

Note!

You can change the status of a message by opening the Status key
and selecting an icon; however, this is unadvisable. Eudora
automatically keeps track of what you do with your messages and you
should not need to change the status.
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Priority
The icons in the priority column indicate how urgent the message is. The sender can name
the priority of the message or you can change the priority once you read the message.

Locate the Priority Column Key

1.  Click once on a message in your In, Out, or Trash mailbox.

2. Place your mouse pointer in the Priority column. Your mouse pointer will
look like the image on the right.

3. Click and hold down on your mouse button. A key to the icons in the Priority
column will appear.

Change Your Message Priority

1. Once the Priority Key is visible, you can place your mouse pointer over a
different priority to highlight it, then release your mouse button. The icon
in your Priority column will change.

Attachments
When you receive an attached file, an icon will appear in your Attachments column that
looks like a piece of paper. Opening attachments is discussed later in this booklet.

Sorting by Column Label
You can sort the messages in any mailbox based on your column headings.

Sort the Items in your Mailbox

1. Click on the column heading you want your mail sorted by, for instance, the
“Who” column. Eudora will sort your mail.
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Creating New Mailboxes
To assist with file management, you can create new mailboxes in Eudora that will store
your mail. For instance, if you receive many messages from Joe Teacher that you want to
save, you may want to create a Joe Teacher mailbox to store your messages from Joe
Teacher.

Create a New Mailbox

1. Click on your Mailbox pull-down menu and select New.

2. A window will appear asking you to name your new mailbox. Type the
mailbox name in the space provided. Leave the “Make it a Folder” box
unchecked     .

3. Click OK. Your mailbox name will now be visible in your Mailbox pull-down
menu.

Transferring Mail to Different Mailboxes
All new mail will, by default, be sent to the In box. Once there, you can transfer your mail
to other mailboxes.

Transfer Mail to Different Mailboxes

1. Click once on the message in your In box that you want to transfer.

2. Open the Transfer pull-down menu and select the mailbox you want to place
your message into. Your message will be transferred.

Note!

To delete a message, you can either transfer it to the Trash mailbox or
select Delete from the Message pull-down menu.

Emptying the Trash
Once you delete a message or transfer it to the Trash mailbox (see Note above), you must
empty the trash in order to completely remove the message from your computer.

Empty the Trash

1. Select Empty Trash from the Special pull-down menu.
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Sending, Replying to, and
Forwarding Mail

Sending a New Message
There a two parts to an email message: the address information and the text. When
sending an email message, the only required address information is the email address of
the person you’re sending the message to.

Send a New Message

1. Select New Message from the Message pull-down menu or click on the New
Message button in the Eudora toolbar. An empty message window will
appear on your desktop and your insertion point will be in the “To” area of
your message.

2. Type the email address of the person you’re sending the message to and then
press Tab on your keyboard. Your insertion point will move to the Subject
area.

3. Type the Subject of your message.

4. If you would like to Cc or Bcc anybody, type his/her email address in the
appropriate space.

5. Use your mouse to place your insertion point in the text area of the message
(below X-Attachments).

6. Type your message. When you are finished with your message, click the
Send button in the upper right corner of your message window.

Chapter
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Tip—Checking Spelling

You can check the spelling in your email messages by going to the
Edit menu and selecting Check Spelling. A program called SpellsWell
will open and check your spelling. This program functions in the same
way as the spelling checker in Microsoft Office.

Tip—Addressing More than One Recipient

You can send an email message to more than one person by
separating email address by a comma and a space. For an example,
see the image below.

Replying to a Message
You can reply to any message you receive. When you choose the reply option, your message
will automatically be addressed to the person who sent the message and the original
message text will appear in your email message.

Reply to a Message

1. Open the email message you want to reply to.

2. Select Reply from the Message pull-down menu or click the Reply button on
the Eudora toolbar. A window will appear with the address information
portion filled out. You can add additional people to the To, Cc, or Bcc area if
you wish.

3. Place your insertion point above or below the original text message and begin
typing. You may need to place your insertion point in front of the first line of
text in the original message and hit return to move the message down—then
you can type above the original message.

4. When you are finished typing, click the Send button in the upper right
corner of the message window.
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Tip—Replying to All

If you receive a message that was sent to multiple people and you
want everyone to see your response, you can “reply to all” by holding
down your Option key on your keyboard while selecting the Reply
button on the toolbar.

Forwarding Mail
When you receive a message from someone that you want someone else to see, you can
forward that message to other people. When you forward a message, you need to fill in
the To, Cc, and/or Bcc address information. The subject will remain the same, but you can
change it if you want to. Additionally, the original address information will appear in
the text portion of your message.

Original Message

Message after Forward was
Selected
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Forwarding a Message

1. Open the email message you want to forward.

2. Select Forward from the Message pull-down menu or click on the Forward
button in the Eudora toolbar. A new window will appear.

3. Fill in the To (required), Cc, and/or Bcc area.

4. Type text, if desired, in the text area of the message.

5. Click the Send button in the upper right corner of your message window.
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Sending and Receiving
Attachments

About Attachments
An attachment is a separate file that is sent to you via the De Anza email server. For
instance, I might send you an email informing you that I finished a report in Microsoft
Word and attach the actual report to my email message. You would then be able to open
that report in Microsoft Word.

Setting Up Your Attachments Folder
You can set up Eudora to place the attachments you receive into a folder of your choice on
your computer. This makes file management easier.

Set up Your Attachments Folder

1. Create a new folder on your computer in a convenient location and name this
folder Attachments.

2. In Eudora, go to the Special pull-down menu and select Settings. A Settings
window will open on your desktop.

3. In the left column of the Settings window, click once on Attachments. (You
may need to scroll in order to find the Attachments option.)

4. Click on the button  below
the “Attachments
Folder:” area in the right
column. A window will
appear.

5. Locate the Attachments
folder you created on your
hard drive, double-click
on it, then click Use
Folder.

6. Click OK in the Settings
window.

Chapter
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Reading Attachments
When you receive an attachment, a paper icon is visible in the Attachment column of your
In window. You should get into the habit of reading the text of an email message before
opening an attachment—sometimes that text gives you clues as to how the attached
document was saved.

Read Your Attachment(s)

1. Double-click on the attachment in your attachments folder—the
attachment will open as well as the application that created the
attachment OR open the application first, then open the attachment.

Sending Attachments
You can send an attachment with any email message, but you should make sure the file
size of the attachment is relatively small. If the file can’t be saved on a disk, you should
break the file up into smaller pieces, especially if you plan to send the attachment to
multiple people on campus with a single email message.

Send an Attachment

1. Create a new email message, filling in the address information and text
area of the message.

2. Go to the Message pull-down menu and select Attach Document or click on
the Attach Document button in the Eudora toolbar. A window will appear
on your desktop.

3. Locate the document you want to attach, click once on it, then click the
Attach button. Your attachment will appear in your address information
area.

4. Click the Send button in the upper right corner of your message window.
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Address Books

Creating Address Book Entries
The Eudora Address Book allows you to file email addresses and easily access them when
addressing email messages. You can create an address book entry for a single person or a
group of people.

Group address book entries are good to create if you have a group of people you regularly
send email messages to. For instance, if you are on the Technology Team, you might have a
group address book entry called Technology Team with a list of everyone’s email address
in the group. You will get a clearer idea of how this works once you create a group address
book entry.

Create an Address Book Entry

1. Select Address Book from the Window pull-down menu. The Address Book
window will appear on your desktop.

2. Click on the New button in the lower left corner of the Address Book
window. A New Nickname window will appear.

3. In the space provided, type a nickname for your address book entry (first or
last names usually work well).

4. Click in the “Put it on the Recipient List” box.

Chapter
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5. Click OK. You will return to the Address Book window.

6. Fill in the fields in the Address Book window—email address is required.

7. Close the Address Book window. You will be prompted to save changes.
Click Yes.

Create an Email Group

1. Follow the steps 1-5 above.

2. In the Address(es) area, type multiple email addresses, pressing Return on
your keyboard after each entry.

3. When you are finished, close the Address Book window. You will be
prompted to save changes. Click Yes.

Tip—Automatic Address Book Entries

When you receive a message from someone and you’d like to include
that person in your address book, click once on their email message in
your inbox, select Make Address Book Entry from the Special menu,
and give the person a nickname.

Using your Address Book
You can use the entries you made in your address book when you create email message.

Go to the Message pull-down menu, select New Message To, then select the person or
group from the submenu that appears. A new message will be started addressed to
that person or group.
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Email Etiquette

Attachment Size
As a general rule, attachments sent to multiple people in our district at once should not be
larger than 1MB. If the file you want to attach can not fit on a floppy disk, you should
probably break it up into smaller pieces before sending it. The email server in our often
has difficulty handling larger capacities than that and people who have older computers
will have difficulty receiving files larger than 1MB.

Leaving Items on the Server
The Eudora Pro program on your computer was configured to pull your email messages from
our email server and save them to your local machine. You should not change this setting
because too many messages left on the server will slow the email process down for
everybody.

Formatting Text in Messages
Eudora Pro gives you options in the Edit menu to change text size, style, and color. Be
aware that people who do not have Eudora Pro 4.0 may not be able to read these text
changes. Formatting features should be reserved for one-on-one email correspondence with
someone you know can read the text style changes and     should not     be used for group email
messages.

Chapter
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Additional Eudora Features

Filters
Filters allow you to automatically manage tasks in Eudora. For instance, you could create
a filter that would automatically take all messages from me and place them in a mailbox
named Heidi.

The online instructions for creating filters are very thorough. If you are interested in
creating filters, select Filtering Messages from the Help pull-down menu and follow
the instructions in the window that appears.

Signatures
A signature is the text that automatically appears at the end of an email message you
send to someone. A signature usually includes your name, phone number, address, office
hours, etc.

If you are interested in creating a signature, select Using Signatures from the Help pull-
down menu and follow the instructions in the window that appears.
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